
Quick Tips to Using I-DEAS
I-DEAS  Tutorials: Fundamental Skills

Learn about:

• windows
• mouse buttons
• applications and tasks
• menus
• icons
• part modeling
• viewing
• selecting
• data management
• using the online tutorials
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Setup 1 of 2

If you didn’t start I-DEAS with a new (empty) model file,
open a new one now by clicking on File, then Open.

 File
Open

I-DEAS Question

Save changes before switching model files?

 Yes

Open Model File form

 Model File name: any unique name

 OK

 OK

Things to notice  
 This symbol is used in the tutorials 
whenever you should select from the top 
menu (either File, Options, or Help).

 This symbol is used whenever you
should click a button on an I-DEAS
form.

 This symbol is used whenever you
should fill in a field on an I-DEAS form.
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Setup 2 of 2

Make sure you’re in the following application and task:

 Design,
Manufacturing, or
Simulation

 Master Modeler

Things to notice  

 This symbol is used in the tutorials
whenever you should select an item
from a pull-down menu.

Save your model file.
 File

Save

Warning!  
If, during this tutorial, you are prompted by I-DEAS to
save your model file, respond:

 No
Save only when the tutorial instructions tell you to––not
when I-DEAS prompts for a save.

If you make a mistake at any time between saves and
can’t recover, you can reopen your model file to the last
save and start over from that point.

Hint  
To reopen your model file to the previous save, press
Control-z.
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Windows 1 of 3

I-DEAS creates four windows on your screen:

1.  Graphics window

2.  I-DEAS List window

3.  I-DEAS Prompt window

4.  I-DEAS Icons window

1

2 3

4
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Windows 2 of 3

1. Graphics  window

The Graphics window displays the workplane and your
parts or assemblies.

2. I-DEAS List  window

The I-DEAS List window displays output information
generated by commands.

3. I-DEAS Prompt  window

The I-DEAS Prompt window prompts you for information
needed to complete a process, such as dimension
values.

4. I-DEAS Icons  window

The I-DEAS Icons window contains the pull-down menus
to change the application or task; it also shows the task,
application, and I-DEAS-wide icons that control the
software.

1

2 3

4
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Windows 3 of 3

If you need to resize the Graphics window to make room
for the online tutorial, click and hold the left mouse
button on the upper left hand corner of the window, and
then drag the left edge of the window to the right. (This
will leave more room for the tutorial.)

Next, click on the Redisplay icon to refresh the Graphics
window.
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Mouse buttons 1 of 2

The three mouse buttons have a consistent use in each
of the I-DEAS applications. The mouse buttons are used
as follows:

 left mouse button

The left mouse button is used for most operations, such
as selecting menus and icons, while some operations
use a “click and drag” or a “double-click” of the left
mouse button.

 middle mouse button

The middle mouse button is the same as the Enter or
Return key, often used to accept the default answer to
prompts, or to end the selection of entities and perform a
command.

 right mouse button

The right mouse button pops up a menu of other choices
such as to modify the mode of picking graphics. When
you use the right mouse button, you hold down the right
button and slide the mouse pointer up or down to select
the desired command. With the command selected,
release the button. If you change your mind and don’t
want to make a choice, slide the mouse pointer to the
side, off the pop-up menu.

The table on the next page summarizes the different
mouse button operations.
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Mouse buttons 2 of 2

Mouse Button Operations

Button Operation Uses

click (quickly) Select icons, menus, and
form entries.
Pick graphic items.

shift-click Pick multiple graphic items,
or deselect items.
Select a range of items in a
form

control-click Select multiple items in a
form.

hold, drag Pop up more icon choices.
Pick items within a boxed
area on the screen.

double-click Used in forms to “open” a
listed item name that is fol-
lowed by ...

multiple clicks “Walk” the part hierarchy,
e.g., first click picks edge
or face, second click picks
the whole part, third click
picks the feature. The
selection is indicated by
being highlighted: a yellow
bounding box on features;
a white bounding box
around the part.

click Same as Return key.
Use to pick default answer,
or to end an operation.

hold, drag Select other pop-up
“Menu” choice.
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Applications and tasks 1 of 3

I-DEAS is divided into “applications,” which are further
divided into “tasks,” a few of which are shown below.

  Applications Tasks

Design Master Modeler

Master Assembly

Mechanism Design

Sheet Metal

Simulation Master Modeler

Boundary Conditions

Meshing

Model Solution

Post Processing

Optimization

Manufacturing Master Modeler

Generative Machining

Assemble Setup

Test Time History

Histogram

Model Preparation

Signal Processing

Modal

Fatigue Life

Post Processing

Drafting Drafting Detailing

Drafting Setup
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Applications and tasks 2 of 3

When you signed on to I-DEAS, you selected an
application and a task on the Start form.

You can also change applications and tasks from the top
of the icon panel when the software is running.

For example, click on the application menu and see the
applications that are available.

Design
Drafting
Simulation
Test
Manufacturing
Management
Open Data/PC B

Make sure you’re still in the application you started in.

 Design
–or–

 Simulation
–or–

 Manufacturing
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Applications and tasks 3 of 3

Now click on the task menu and see the tasks that are
available.

Master Modeler
Master Assembly
Mechanism Design
Harness Design
Drafting Setup
Relational Data Manager

Make sure you’re still in the Master Modeler task.

 Master Modeler

Things to notice  
These two menus let you know exactly where you are.
That is, if you look at the menus now, you know what
application you are in, and that you are in the Master
Modeler task.

When you switch to another application and task, the
icons on the icon panel change. You will learn more
about these later in this tutorial.
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Menus 1 of 4

In addition to the application and task menus (which
you’ve already seen), the I-DEAS Icons window has
three additional menus at the top.

File   Options   Help

File  menu

Click on the File menu.

 File

Open...
Save
Save As...
Export...
Import...
Program Files
Picture Files...
Plot...
Movie
Exit

Things to notice  
Some of these options may not be available on your
platform. If an option is not available, it will be either
grayed-out or not on the list.
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Menus 2 of 4

Recovery Point

 File
Save

If you did not enter a model file name on the Start
form, the software will ask you to enter a name now.

 Model File name: enter any name

Check I-DEAS List . 
Look at the I-DEAS List window. A message will tell
you that your model file has been saved.
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Menus 3 of 4

Options  menu

Now click on the Options menu.

 Options

Units
Preferences...
Color Palette...
Background Color
Menus On/Off

Click on Units.
 Options

Units

Things to notice  
A menu of the different options for units is displayed.

For this tutorial, set the units to millimeters.

  mm (milli newton)
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Menus 4 of 4

Help menu
Click on the Help menu.

 Help

What’s New...
On Context
––––––––
Getting Started...
Tutorials...
Manuals  >
––––––––
Web  >
Quick On/Off
About...

Things to notice  
You can use the Help menu when you need help or want
to get information about an icon, process, task, etc.

Click on About...
 Help

About

Help on Version form

 OK

Recovery Point

 File
Save
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Icons 1 of 6

The icon panel in the I-DEAS Icons window is divided
into three sections.

     
     top section = task icons

     middle section = application icons

     bottom section = display and view icons

Move the mouse over the icon panel and notice the
Quick Help text at the bottom-left of the Graphics
window.

Creates a series of lines that are connected end-to-end

Displays history tree access form for a selected part

Redraws graphics window
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Icons 2 of 6

You select icons by clicking them with the left mouse
button. Click quickly on the Polylines icon with the left
mouse button.

Things to notice  
Notice that the Polylines icon is highlighted, which
indicates that it has been selected and is active.

Since the Polylines icon is active, I-DEAS is expecting
you to sketch something. You’ll start sketching a little
later in the tutorial. To deactivate the icon, press the
middle mouse mouse while the cursor is in the Graphics
window.

 (to deactivate the command)



1

2

1

2 3

1
3
2
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Icons 3 of 6

Most of the icons are organized into stacks of related
icons. Click and hold on the Polylines icon. Notice how a
stack of related icons is displayed.

To select one of the icons in the stack, move the
mouse pointer up and down the stack until the
border of the one you want highlights (looks
beveled), then release the mouse button.

Polylines

Lines

Rectangle by 2 Corners

Rectangle by 3 Corners

Rectangle by Center

Points

Practice by selecting the Lines icon from the stack.
When you do, the Lines icon comes to the top of the
stack, and is highlighted.
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Icons 4 of 6

Things to notice  
Notice that a prompt is given asking you to “Locate
start.” Also, an odometer is shown in the upper corner of
the Graphics window to show your XY locations. Move
the mouse and watch the odometer change.

Draw a few lines, clicking once with the left mouse
button for the start of the line, and once with the left
mouse button for the end of the line. Don’t worry if some
of your lines have dimensions shown.

Check I-DEAS Prompt . 
Get in the habit of watching the I-DEAS Prompt
window for questions and instructions.

1 2

3 45

6 7

89 10

Terminate the Lines icon by pressing the middle mouse
button.

 (to deactivate icon)

Things to notice  

1  This symbol is used throughout the tutorials
whenever you should use the left mouse button to
click on the corresponding position shown on the
sketch or part.
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Icons 5 of 6

Next, reopen your model file to the last save, so you’ll
have an empty workbench to sketch the next shape.

Hint  

 (to deactivate the command)

 Control-z

Click on the Polylines icon with the left mouse button.

Sketch the boundary as shown below, using the left
mouse button to pick points 1 through 6. Don’t worry
about the dimensions.

After picking point 6, terminate the command by
pressing the middle mouse button.

1
2

3

4

6

5

Things to notice  
Notice that the Polylines icon is no longer highlighted.
You ended the command when you pressed the middle
mouse button.
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Icons 6 of 6

To have nothing in the Graphics window for the next
section, delete your sketch.

1  click and hold the left mouse button down while
you drag a box to surround the sketch

2  release the left mouse button

1

2

 (to indicate Done)

 Yes

 (to deactivate icon)
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Part modeling 1 of 4

The part modeling process is a process of adding
features. The typical process is:

1.  Select a workplane or part face.

2.  Sketch and constrain.

3.  Create a feature (extrude, revolve, etc.).

In this section, you’ll sketch a shape and add features to
model a part like the one shown.
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Part modeling 2 of 4

In a front view, use the Polylines icon to sketch a closed
shape something like the one shown below. Don’t worry
about dimensions.

Y

X

1
2

3

4

6

5

7

9

8

Remember  
After picking point 9, terminate the command by pressing
the middle mouse button.
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Part modeling 3 of 4

Select an isometric view.  Use the Extrude command to
extrude this shape into a solid part.

X
Y

Z

1   pick any line

  (to indicate Done)

1
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Part modeling 4 of 4

Extrude Section form

  Distance: 100

  OK

Recovery Point
 File

Save
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Viewing 1 of 3

The icons in the lower left corner of the icon panel
change the viewing direction to front, top, right, and
isometric view.

Try each of the icons to see how the view changes.

Y

X

X
Y

Z

Z

Y

X

Z

Switch to isometric view before continuing.

X
Y

Z
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Viewing 2 of 3

Try the following function keys to dynamically change the
view.

Make sure you have “focus” by clicking in the
I-DEAS Graphics window, or when you press F1,
your Acrobat Reader Help will be displayed. If this
happens, use File, Close in the Help window––not
File, Exit.

F1 – pan

Hint  
Start with the mouse pointer in the center of the
Graphics window, hold down the F1 function key, and
move the mouse to pan left and right, or up and down on
the screen.

F2 – zoom

Hint  
Start with the mouse pointer in the center of the
Graphics window, hold down the F2 function key, and
move the mouse down to zoom in, up to zoom out.
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Viewing 3 of 3

F3 – 2D and 3D rotation

Hint  
• 2D––start with the mouse pointer near a corner of

the Graphics window, hold down the F3 function
key, and rotate around the center of the screen.

Hint  
• 3D––start with the mouse pointer in the center of

the Graphics window, hold down the F3 function
key, and move the mouse up/down or left/right.

When you’re finished, switch to isometric view and
zoom all.

X
Y

Z
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Selecting 1 of 3

Move the mouse pointer over the part in the Graphics
window.

Things to notice  
Notice how the lines are pre-highlighted even before you
click to select.

1  click on one line using the left mouse button

1

2  hold down the Shift key and click on another line
using the left mouse button

2

Things to notice  
The first line remains selected.

Leave these two entities selected and continue to
the next page.
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Selecting 2 of 3

 Click and hold the right mouse button. When
you do, a menu appears.

While holding the right mouse button down, move the
pointer up and down the pop-up menu and when All is
selected, release the mouse button.

Visible
Label
Filter...
Area Options...
Reconsider
Deselect All
Related To
History Access...
Use Design Groups...
All
Show
Highlight Selection
Backup Selection
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Selecting 3 of 3

Things to notice  
All entities of the same type that are selected (in this
case lines) are highlighted.

If your lines aren’t highlighted, look in the I-DEAS
List window to see if it tells you to use the
Highlight_Selection option. If it does, hold your right
mouse button down and select the option from the
menu.

 Highlight Selection

Use the right mouse button menu to deselect all the
lines.

 Deselect All
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Data management 1 of 3

The parts you create will be organized into projects.
There will typically be many projects in your data
installation. Each project can contain multiple libraries
and catalogs for shared data, and model files for
personal scratch areas.

Model files are further subdivided into bins, which are
storage containers used to help you organize and
manage your parts.

Parts need to be named to be used by other
applications. Give the part you just created the name
“First Part.”

Pull down the icon stack and select the Name
Parts... icon. Then release the mouse button.

XXX

  pick anywhere on the part

Name form

  Name: First Part

  OK

  (to indicate Done)
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Data management 2 of 3

Save your changes to your model file.
 File

Save

Select the Manage Bins icon to see what is in your
model file.

Pull down the icon stack to select the Manage Bins
icon.

Manage form

The Manage form shows you that your part is assigned
to the default bin (the default bin is called the “Main” bin).

Dismiss the Manage form.

 Dismiss

Bins and libraries are explained in detail in
subsequent tutorials.
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Data management 3 of 3

Although you just saw that the part was “assigned” to the
main bin, it isn’t “in” the bin yet.

Put your part away to the bin.

 pick anywhere on part

 (to indicate Done)
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Using the online tutorials

The online tutorial you take next depends on your area
of interest. The tutorials are designed and organized to
take you through a learning path to teach you the skills
necessary to perform certain activities. The available
paths are:

• Design – Part Modeling
• Design – Surfacing
• Design – Assemblies
• Drafting
• Simulation
• Manufacturing
• Test

Some of these paths have two levels of tutorials:

 1 – Fundamental Skills

 2 – Advanced Projects

Some tutorials are required before continuing to the next
step, while others are optional, but highly recommended.
As you progress through a path, each tutorial will tell you
what is required, what is recommended, and where you
should go next.
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Tutorial wrap-up

You have completed the Quick Tips to Using I-DEAS
tutorial.

See also...
For additional information on many of the concepts
covered in this tutorial, see the following in the I-DEAS
Help facility:

 Help, Getting Started
 Help, Manuals, Table of Contents

Interacting with I-DEAS
Getting Started with the Software

What’s next?
To continue, exit the tutorial window by selecting:

 File
Exit

After exiting, choose the Fundamental Skills tutorial that
is next in the learning path you are following.

Warning!  
Do not use the menu in the I-DEAS Icons window to exit.
Use the menu in the tutorial window.
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